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Instruction Manual for the USB Flight Data Recorder (Standard and Pro)
 

Patent Pending 
 

Document Version 3.7,  Model # FDR-02 and FDR-PRO 

 
 

Thank you for your purchase!   This instruction manual will guide you through the installation and operation of 

your Flight Data Recorder Version 2, and FDR PRO.   Please read the entire manual carefully before proceeding.    

If, after you read the manual (including the Troubleshooting sections!) you have further questions or problems, see 

the Flight Support page on http://www.eagletreesystems.com for additional information, or email us at 

support@eagletreesystems.com.   Please also fill out the registration form at the end of this manual if you did not 

purchase your Recorder directly from Eagle Tree Systems, so we can send you important update information. 
 

Steps to Follow 
 

Installation and use of the Flight Data Recorder will be quite easy and enjoyable if you follow these few steps: 

 

1. Read through the manual to understand the warnings, determine what parameters you want to log, etc.   

2. Install the Recorder in your model, as described in the Recorder Installation section below.   Pay special attention to the 

polarity and plug-in location of the sensors, since some of the plugs will fit in more than one location! 

3. Install and configure the Windows software as described in the Windows installation section below.   Note that you will need 

to bring your model near your computer for this step. 

4. Bench and range test your model, and have fun! 

 

Intended Uses 
 

The Flight Data Recorder System was designed for use in Unmanned Radio Controlled airplanes and helicopters.   Using the Recorder 

for other purposes is not supported.    Further, using the Recorder in situations where its use or failure could result in loss of life, 

bodily injury or property damage is expressly prohibited. 

 

Packing List 
 
Your package should include the following:  Flight Data Recorder, 4 ‘Y’ Cables, 3 feet of Pitot Tube hose, plastic Pitot Tube 

extension, 1 Temperature Sensor, 1 RPM sensor, 4 tiny magnets, Custom USB Cable, and CD-ROM. 

 

If you purchased the FDR PRO, your package will include the following additional items, and will NOT contain the plastic Pitot Tube 

extension:   brass pitot tube, brass static tube, plastic ‘T’ fitting, and two 3 foot lengths of pitot tube hose. 

 

 Optional expanders for measuring G-Force, Exhaust Gas Temperature, Electric Motor Current/Voltage, GPS, Fuel, secondary RPM , 

Spark RPM, and other parameters are available from Eagle Tree Systems.    An External Hookup Kit is also available for downloading 

and controlling your recorder without removing your wing. 
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Installation of the Recorder  
 

WARNING:  As always, it is very important that you range and function test your model on the ground once 

the Recorder is installed to ensure that there is no impact on your system. 

 

Make sure that your “antenna down” operating range is within the manufacturer’s specifications.   See your 

Radio owner’s manual for the correct procedure for your equipment.    It is always best to do the range check 

in the flying configuration, for example with the engine running.   DO NOT FLY IF YOUR MODEL 

DOESN’T PASS THE RANGE CHECK!! 
 

NOTE: The recorder’s label has a handy color coded means of indicating the polarity of the various connectors.    The red dots on 

the label, which are on only one side of the text corresponding to each input,  indicate on which side of the plug the red wire 

should go. 

 

Powering the Recorder and Connecting the Recorder to Your Aircraft’s Servos and Receiver 
 

First, determine if you wish to log servo positions.    If you decide to log servo positions, you will be connecting the Recorder to your 

receiver via the ‘Y’ cables.    In this configuration, the Recorder is powered from your receiver battery.     

 

If you decide not to log servo positions, you can still power the 

Recorder from your receiver battery by connecting one of the Y 

cables from a spare receiver channel to the Recorder (or use 

your own 2-3 wire connector). 

 

If you want to power the Recorder from a separate battery, 

meaning that you want complete electrical isolation between the 

Recorder and your receiver, you can power the Recorder with a 

small separate battery as described in the Installing Battery 

Backup Harness section below. 

 

The Recorder includes four custom, heavy duty ‘Y’ cables with 

Universal connectors which install in line between your throttle, 

rudder, aileron and elevator servos and your radio receiver.    

Connection of the ‘Y’ cables is simple:  connect the center 

(male) keyed connector of the ‘Y’ to one of the 4 keyed slots 

servo slots in the recorder (see Figure 1), connect the remaining 

male connector one of the channels on your receiver, and connect the female ‘Y’ connector to the servo which you previously 

connected to that channel of the receiver.    Note: It doesn’t matter which of the 4 keyed recorder slots you plug your ‘Y’ cables into – 

the Recorder Application will automatically detect which servos are connected where during application setup. 

 

WARNING:   Do not connect ‘Y’ cables to any other location on the recorder.   Doing so may damage the recorder or other 

components. 

 

Note: the Recorder, which draws only around 35 mA of current, draws power from the ‘Y’ cables.   All standard receivers we are 

aware of hardwire the power and ground wires from the battery to the power and ground wires of the servos, so the Recorder is in 

reality directly connected to the battery. 

 

Note:  The ‘Y’ cables included should be compatible with most of the currently available receivers, such as Futaba™, JR™, Tower™, 

and HiTec™.   The pinout of the ‘Y” cables is as follows:  Black = ground,   Red = power, White = servo signal. 

 

WARNING: It is your responsibility to make sure that your receiver and servos are pin compatible with the Y cables before 

connecting.   Serious damage could result to your receiver, servo or recorder if they are not compatible.  

 

Connecting the Airspeed Pitot Tube 
 

WARNING:  If you mount the Pitot Tube in such a way that it might induce drag on your model, you need to make sure that 

it won’t cause the model to become unstable during flight! 
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The Recorder uses pressure differential via a Pitot Tube (a piece of small fuel tubing which you will fit with a short 

piece of plastic insert, supplied) to measure airspeed, just as full size planes do.     The static port of the pitot sensor for the Flight Data 

Recorder V2 is located inside the Recorder.    The static and pitot ports for the FDR PRO are on the side of the recorder. 

 

The length of the tube should not have a significant effect on airspeed measurement, so it should be no problem to lengthen or shorten 

the supplied tube.   We have also received reports that changing the plastic insert with metal or other rigid tubing also does not affect 

airspeed measurement. 

 

NOTE:  It is of course not necessary to use the Pitot Tube with the Recorder if you are not interested in measuring airspeed – the other 

functions of the Recorder will work without airspeed readings. 

 

NOTE:  Additional Pitot Tube kits are available for purchase on our website. 

 

The following instructions apply to installing the Pitot Tube in the Flight Data Recorder V2 (see below for FDR PRO Pitot/Static 

installation instructions): 

 

The end of the Pitot Tube without the plastic insert is connected to the nipple through the small hole in the top of the Recorder, which 

is labeled “Speed.”   See Figure 1 below.   To connect the hose, press the hose down over the nipple while rotating the tubing back and 

forth.   Once it is on, tug it lightly to ensure it’s well attached. Lightly moistening the end of the rubber tube can ease installation. 

 

Cut off an approximately 1 inch piece of the supplied plastic insert, and insert it partway into the other end of the tube.    Alternatively, 

you can use brass or other tubing of similar size.    

 

The pickup end of the Tube should be positioned somewhere on the plane where the mouth of the insert will be pointing toward the 

direction of the plane’s travel, into the wind.   It’s important that the tube be placed so that it is not directly in the plane’s prop-wash, 

which will result in erroneous readings.    Some good places to install the tube are on the leading edge of the wing several inches out 

from the fuselage and out of the propwash, or on the landing gear. 

 

For wing mounts, the tube can be mounted temporarily with Scotch tape, plumber’s putty, or other, or for more permanent 

installations in new (or crashed) planes, it can be installed in a small hole drilled in the leading edge of the wing and the tube run 

inside the wing and into the fuselage.      

 

It’s important that the Pitot Tube’s plastic insert is kept rigid and pointing directly into the wind (the direction of the plane’s travel).    

For temporary installations, one simple way to do this is to apply a small lump of plumber’s putty around the insert at the leading edge 

of the wing to keep it rigid. 

 

For landing gear mounts, it may make mounting easier to replace the Tube’s short plastic insert with the longer plastic insert, or you 

can purchase a length of brass tubing for more rigidity.   Either can be bent into an ‘L’ shape and held in place with glue, zip-ties, or 

tape.    

 

The following instructions apply to installing the Pitot/Static Tube in the FDR PRO: 

 

The FDR PRO has separate accessible ports for airspeed pitot and static measurements, and altitude static measurement.   See Figure 

1-B below. 

 

Included with your kit are two brass tubes, which can be installed in your model.    The pitot tube is mounted so that it is parallel to the 

direction of travel, as shown in the figure below.    Make sure that the pitot tube is extending well into undisturbed air, away from any 

propwash. 

 

There are 3 options for providing a static source, depending on the nature of the airframe, the desired level of accuracy, permanence of 

installation, and other factors: 

 

Option A:  A true static pickup can be created with the included second brass tube.   To create the static pickup, you will need to drill 

4 small holes into the side of the tube, spaced equally around the circumference of the tube. If it is difficult to drill all four holes 

around the tube in a circle, two of the holes can be drilled farther forward than the other two.   Also, a larger diameter tube can be used 

to make this easier, if the extra weight can be accommodated.    

These holes should be drilled 1.5” or more from the front of the tube, but should not be too close to the tube mount.     The holes 

should be approximately 1/32” in diameter, and should be deburred if there are burrs from drilling.    Once the holes are drilled, the 

front opening of the tube should be plugged with epoxy or other.    The static tube is mounted parallel to the direction of travel, near 

the pitot tube, as shown in the below figure.    

 



 

Copyright © 2003-2005 Eagle Tree Systems, LLC  

 

Page 4 

Option B:  A static source can be obtained from the side of the fuselage, with the rubber tube (or a short piece cut from 

the brass tube) mounted absolutely flush with the side of the fuselage, so that the mouth of the tube is pointing perpendicular to the 

direction of plane travel.     The location of the static tube should be chosen so that the least disturbance of air possible occurs.    

 

Option C:   If the airplane’s fuselage is relatively sealed, with no large “ram” air openings in the nose of the plane, you can likely 

obtain good readings by just leaving the altitude and static airspeed connections unconnected, and only connecting the airspeed pitot 

tube. 

 

 

Installing the Temperature Sensor(s)  
   

One temperature sensor is included with the Recorder – an additional sensor can be ordered separately.   The temperature sensors are 

typically installed by placing the black wire loop around the cylinder head, and cinching it in place by pulling the two rubber stays 

snugly against the engine.   Normally the highest temperatures are experienced near the base of the engine, but experience will dictate 

where your particular engine best reads heat.  Other mounting arrangements are possible, such as obtaining a metal washer with a tab, 

carefully bending the tab around the sensor portion of the wire loop, and installing the washer under your glow plug, or installing the 

sensor under a dedicated tapped screw in the cylinder head.    Note that since various mounting locations and brands of temperature 

devices on the market will read differently, the most important aspect of temperature 

measurement is learning how your engine reads under various conditions, and adjusting based 

on relative temperature readings.      Plug the Futaba style connector from the sensor into the 

recorder as shown in Figure 1.  

 

 Note:  the Temperature Sensor lead can be easily extended with a standard servo extension 

cable. 

 

Installing the RPM Sensor 

 

Installing the RPM sensor and magnets is the most challenging part of installation, but is 

relatively easy once a good mounting location is determined.  Refer to our website’s Flight 

support page at http://www.eagletreesystems.com for pictures of example installations.    
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To install our magnets, first find a suitable location on your engine’s motor to attach either one or two small magnets 

and RPM sensor.   Typically, the prop washer or prop hub are ideal locations.   This will of course vary with make and model of plane.  

Make sure the magnets are mounted on some structure that doesn’t “flop around,” as the magnets could hit the sensor in this case.     

The RPM sensor must be mounted so that it does not move around, and is within 1-2 mm of the two magnets as they spin.    On 

typical plane installations, there’s usually a place where the back of the sensor can be glued to a flat surface under or over the hub 

which has the magnets mounted.    The Recorder kit includes four magnets.  That provides you with up to 3 spares.    

           

         

Installing Magnets 

 

Once you have determined where to install the magnets, decide whether you will drill a hole so that the magnets will mount flush with 

the surface, or if you will just glue the magnets to the surface.    Though somewhat more difficult and permanent, mounting the 

magnet flush with the surface is the best long term approach, since the mounting will be much more rugged, and the risk of imbalance 

due to not mounting the magnets exactly 180 degrees apart is reduced.    In fact, if the magnet is mounted flush in another metal 

material, it is quite possible that no shaft imbalance will occur if you only mount one of the magnets total.    

 

To flush mount the magnets, drill a hole just slightly larger than the diameter of the magnet size you choose, and of the same depth as 

that magnet.    If you decide to surface mount the magnets, thoroughly clean this area and lightly scuff it to improve adhesion.     Glue 

the magnets with the side marked with a red line facing inward (hidden), using epoxy, or other strong, suitable glue.  It’s important 

that the red line on the magnets faces away from the sensor once the sensor is installed.    The magnets should be glued 180 degrees 

apart to keep the shaft in balance. 

 

WARNING:  make sure that the magnets are glued sufficiently so that they will not detach and create a hazard, and always 

wear safety glasses when your engine is running!     It is also a good idea to put a piece of heatshrink tubing or electrical tape 

around the magnets, to further secure them. 

 

Using Existing Magnets 

 

Note:  if your engine already has magnets mounted for some other purpose, there’s a good chance you can use them.   Take one of the 

magnets included with your recorder, and put that magnet up against the previously mounted magnet.   If the red line of the Recorder 

magnet faces down so that the sensor can be mounted facing the side of the magnet with no red line, mount the sensor with the printed 

side toward the magnet.    If the side of the magnet with the red line is visible when on top of the previous magnet, the polarity is 

reversed.   This should work correctly if you install our sensor backwards (printed side of sensor away from magnets), though we have 

not tried it. 

 

We are often asked whether existing magnets on spark ignition engines can be used.  The answer is “yes” in most cases, if you can 

install the sensor near enough to rotating magnets.   We have found that these engines typically have 3 magnets, with 2 magnets 

mounted with one polarity, and the other one with another polarity.    The easiest way to use these magnets is to install the sensor with 

the printed side facing the magnets (as described below) then run the motor and see what RPMs are recorded after setting up the gear 

ratio.    If the RPM looks like it is only half of the correct value, double the gear ratio value you entered, to compensate for only one 

magnet being in the right polarity.    We have received problem reports of RPM reading errors when the RPM sensor is mounted very 

near the magneto of spark engines, so we recommend mounting it 180 degrees away from the magneto, or as far away as possible. 

 

Installing the RPM Sensor 

 

Once the magnets are glued and completely dry, temporarily position the RPM sensor so that the side of the sensor with printing (or 

colored dot) is facing the side of the magnets WITHOUT the red line.   The sensor now needs to be glued so that it is held rigidly 

into position.   Before gluing, put a small spacer (1-2 mm thick) between the sensor and one of the magnets to ensure proper spacing.      

 

If desired, a small piece of brass tubing can be glued or heatshrunk to the back of the sensor to ease mounting and increase stability. 

 

After the sensor is glued and completely dry, remove the small spacer and rotate the propeller to ensure complete freedom of 

movement.   Also make sure that the sensor won’t vibrate and come in contact with the magnets during driving.   If this happens, the 

sensor will be destroyed, and the Recorder could be damaged. 

 

Once these steps are complete, plug the Futaba style connector on the sensor into the recorder as shown in figure 1.     Note that a 

standard Futaba style servo extension cable can be used to lengthen the wire if needed. 

 

Using Existing RPM Sensors 

 

Several of our customers have been able to use existing RPM sensors, such as governors or turbine sensors,  with our products.    The 

following steps must be followed: 
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1) Determine the “pinout” of the existing sensor.   Compatible sensors will have Power, Ground, and Signal connections.   The 

Recorder’s RPM pinout, from left to right, is:   Power (black wire), Ground (red wire), Signal (white wire).    

2) Devise a “Y” cable to connect your existing sensor to it’s connection, and also to the Recorder’s RPM connection.    NOTE: 

Power for the sensor should come only from the connection the sensor is normally plugged into.   So,  only Gound and Signal 

wires should be routed from the existing sensor to the recorder.    The power wire of the Y cable between the sensor and the 

recorder should be cut before connecting it to the recorder.    This is necessary to avoid connecting the power of the existing 

sensor connection to the Recorder’s power connection. 

3) Thoroughly test the system to make sure the sensor still works with whatever it was originally connected to, after Y’ing to the 

recorder. 

 

Installing a Secondary RPM Sensor 

 

A second MODIFIED RPM sensor can be plugged into the unused servo port nearest the switch on the recorder, for measuring RPM 

of multiple motors.    This RPM sensor must be modified by swapping the red and black wires in the RPM sensor plug.    Carefully 

pry back the plastic tabs that hold each pin in the plug, remove the red and black pins, and re-install them so that the pin order is RED, 

BLACK, WHITE.   The second RPM sensor plugs into the servo port with the red wire to the right, nearest the edge of the recorder. 

 

The second RPM channel is automatically set up with the same gear ratio as the primary RPM.      

 

With the PRO recorder, up to 3 secondary RPM sensors can be used, for a total of 4 RPMs.     The secondary RPM sensors plug into 

the 3 servo slots nearest the switch on the Recorder.    Each of the secondary RPM sensors MUST be modified as above. 

 

The secondary RPM sensor(s) are logged and displayed on the screens with the other parameters, as described below. 

 

NOTE: When using secondary RPM sensors in any of the servo ports, servo port monitoring will not work correctly.   It is a good idea 

to select “Do not calibrate servos” in the New Model Wizard if you plan on using multiple RPMs. 

 

NOTE: for the secondary RPM sensor to work, there has to be voltage from 4.5 to 6.5 V supplied to one or more of the servo inputs 

(as shown in Figure 1).     This is normally done with the Y Cables, a separate battery, or your BEC. 

 

Altitude Measurement 
 

The Recorder measures altitude via a sensor inside the unit.   Altimeters measure slight pressure differences to determine elevation.   

Since these pressure differences are relatively small, it’s important that the airplane’s internal pressure doesn’t vary much due to 

propwash or moving through the air.    Such variation can occur if the front portion of the plane has an opening that causes air to 

compress inside of the plane when air is forced into this opening.    If you have a problem with inconsistent altitude measurements and 

you think your plane may not be airtight up front, see the Troubleshooting section at the bottom. 

 

Installing the Optional Battery Backup Harness 
 

In most cases, the Recorder can be successfully powered by the Y cables from the receiver.    If you have problems with recorder 

power during acceleration or steering, as described in the troubleshooting section, this can be remedied by adding a small backup 

battery to power the recorder.    To add the backup battery, plug the larger end of the optional backup harness into the recorder.   The 

backup harness is a two wire cable with a Futaba style male connector on one end, and a larger male connector on the other end.     

The large end of the backup harness plugs into the USB port of the recorder, with the red wire in the same place as the red wire of the 

USB cable (as shown in the drawing).      

 

The backup battery must be at least 4.5volts to power the recorder.   Power is only drawn from the backup battery when the voltage 

being supplied through the Y cables drops below the voltage of the backup battery, so if you use a 4.5 volt backup battery, no power 

should be drawn from it except for moments when the main battery drops below this voltage.    Therefore, it is possible to use a very 

small pack (a tiny 4 cell pack or possibly 3 watch type batteries) as the backup battery.    Note of course that the backup battery must 

be disconnected whenever the receiver is turned off, as it will power the recorder whenever power is not supplied to the recorder from 

the receiver.    If you want to get fancy, you could add a DPDT switch in place of the standard receiver switch and turn off the backup 

battery whenever you turn off the receiver. 

 

Removing the Recorder from your Plane 
 

When you remove the Recorder, your servos are still connected to your receiver so it’s not necessary to remove the ‘Y’ cables from 

the plane to operate it without the Recorder.     Be sure however that the connectors are kept from shorting.      
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Note:   Additional ‘Y’ cables, RPM sensors and temperature sensors are available for purchase on our website if you wish to install 

and leave ‘Y’ cables in more than one plane.    This makes it very easy to use the same recorder with multiple Flights.     

 

Also, there is an external hookup kit available from Eagle Tree Systems which extends the USB, pushbutton and LED to the outside of 

your plane.   This allows for easy downloading and control of the Recorder without removing the canopy or wing. 

 

Installing and Using the Windows™ Application  

 

Installing the Windows Application 
 

The supplied Windows application is compatible with USB equipped PCs running Windows 98SE, Millennium, Win 2K, and Win 

XP.   The application is not compatible with Windows 98 Original Edition (Gold), or NT 4, even if the PC has USB support. 

 

NOTE:  the application included on CD with the unit was current at the time of manufacture.   Please check our Flight Support page 

on http://eagletreesystems.com to see if there is a newer version of the app which may have addressed issues you could encounter. 

 

To install the application, just place the CD in the CD-ROM drive.   If AutoPlay is enabled on your PC, the setup program should run 

automatically.   If it does not run, click on My Computer, click on the icon for your CD-ROM drive, and click on the “Flight Data 

Recorder” application icon in the drive window.  

 

Follow the Setup Wizard to install the Recorder application.   Once installation is complete, the Recorder may be launched either from 

its Desktop Icon, or by choosing the Recorder application from the Start->Programs->Eagle Tree Systems folder. 

 

Setting up the Recorder with the Application 

 
Once the application is installed, follow the above steps to launch it.   The first time the application is launched, the New Model 

Wizard will be invoked. 

 

The Wizard will prompt you to install the Recorder using the supplied USB cable.   

  

Warning:  Make sure you connect the custom USB plug with the correct polarity, and into the correct connector on the Recorder, 

as shown in Figure 1.  Not doing this could cause damage! 

 

When you do this for the first time, the behavior will be different depending on which version of Windows you are using: 

 

Windows 98™:  The Recorder and application are not compatible with Windows 98. 

 

Windows 98SE™ and Windows Millennium™:   When the Recorder is first connected to the USB port, the New Hardware Wizard 

will likely appear.   Follow the steps in the Wizard, choosing the options to allow Windows to find the appropriate drivers for the 

Recorder – these drivers are built into Windows.   If the devices you already have on your computer haven’t required the installation 

of the USB drivers, Windows will prompt you for your Windows CD to copy over the drivers.     Once this process is complete, you 

may be asked to reboot the system.   Reboot at this point, then relaunch the Recorder Application, and the New Flight Wizard should 

start up again.    

 

Windows 2000 ™ and Windows XP ™:  When the Recorder is first connected to the USB port, Windows should automatically 

install the correct drivers without prompting you.   If you should receive a Windows prompt, however, do what it says. 

 

Once the Recorder is correctly discovered and installed by Windows, continue on with the New Flight Wizard, relaunching the app 

after reboot if necessary. 

 

Telling the Recorder what to Log 
 

The first time you run the app, you will be prompted to choose what driving parameters you wish to log.   The more items you log, the 

less record time will be available.     A description of the parameters is below: 

 

Servo movements:   If one or more of these parameters is checked, the recorder will log the positions of the corresponding servos.   

Choose these options if you want to see controller movements during your flight, etc.   .      
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Receiver Battery Voltage:  Selecting this parameter causes the recorder to log your receiver’s battery voltage (or 

whatever battery is being used to power the servos).    Note that it is normal to see rapid spikes in the receiver battery voltage on 

playback, but if you are seeing voltage drops below 4.5 volts on a regular basis, you should test your battery.    The Recorder 

constantly monitors battery voltage even if this option is not checked, and will shut itself down if the battery voltage consistently is 

below around 4.5 volts to save power for the receiver.    The recorder will log an error in this case.   The recorder will “reboot” if the 

voltage falls below 4.35 volts even for a short period, and logs an error in this case also.   Error logs are displayed in the “Notification 

Area” of the application during playback. 

 

Servo Glitches:  If this option is selected, the recorder detects and logs three different types of servo glitches:  short servo pulses (less 

than 740uSec), long servo pulses (greater than 2.25 mSec) and missing servo pulses (no pulse for 100mSec).    The most common 

causes of glitches are low receiver or transmitter battery, driving out of range of your transmitter, or defective receiver.   Note that it is 

normal to see a series of glitch notifications right after the recorder or the transmitter is powered up. 

 

Speed:  If this option is selected, the recorder logs the speed of your plane via the air pitot tube.  

 

Altitude: If this option is selected, the recorder logs the flight’s altitude with each sample. 

 

RPM: If this option is selected, the recorder logs the RPM of your Flight.    

 

Temperature 1:  Choose this option if you want to record temperature from the supplied temperature sensor. 

 

Temperature 2:  Choose this option if you want to record temperature from one additional temperature sensor, sold separately. 

 

Optional Accessories:  See the instruction manuals included with the optional accessories for information on logging these 

parameters.   Optional expanders for measuring G-Force, Exhaust Gas Temperature, Electric Motor Current/Voltage, and other 

parameters are available from Eagle Tree Systems.  

 

Setting the Joystick Configuration Mode  
 

The Recorder application defaults to US Mode 2 Joystick configuration, which is: 

 

• Left Joystick controls throttle and rudder, and Right Joystick controls elevator and ailerons. 

 

If you desire, you can select US Mode 1 via the Tools->Set Joystick Configuration Mode.  Mode 1 is: 

 

• Left Joystick controls elevator and rudder, and Right Joystick controls throttle and ailerons.  

 

Setting the “Stop on Full” Feature 
 

After you complete the New Model Wizard for the first time, you will be prompted to choose whether you want the recorder to write 

over its data when its buffer becomes full, or to stop when the Recorder is full.    NOTE: You can change this setting later from the 

Tools menu. 

 

Setting the “Set Capture Rate” Feature 

 
The Recorder can be adjusted to capture data in during flight at five different rates.     The faster the capture rate, the more data is 

obtained, but at the expense of record time.    The default rate, four samples/second, gives good resolution and reasonable record 

times.   You may find that you can get plenty of record time even with the highest capture rate setting, however. 

 

A note on record time:   The recorder uses advanced data compression to get the most data recorded as possible.   When your plane is 

sitting idle before or after flying with the battery turned on, the recorder is still capturing data, but since not much is changing very 

little data is recorded.   But when the plane is actively being flown lots of data is being recorded.    

 

Note: You can change this setting later from the Tools menu. 

 

Setting the “Choose What to Display” Feature 
 

The Recorder Application can display several flight parameters in both numeric and instrument format.   Select the parameters you 

wish the Application to display with this dialog box.    Note that some of the parameters require optional accessories, available from 
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Eagle Tree Systems.    Also note that the display area is limited, so not all parameters can be displayed at once.   

Numeric parameters take up less space than instruments, so more numeric parameters can be displayed at once. 

 

Note:  Select the “Metric” checkbox on this dialog if you want metric operation.   Also, you can change this setting later from the 

Tools menu. 

 

Setting the RPM to Motor Revolutions Parameter 

 
For the Recorder Application to correctly determine the RPM of your motor, you must tell the application how the rotation of the 

motor relates to the rotation of the magnets.   The first time you run the app, you will be prompted to enter this information. 

 

Enter the number of times your motor turns with each rotation of the magnets as described in this dialog box.     

 

Note: You can change this setting later from the Tools menu. 

 

Using the Recorder 
 

Once the Recorder and application is installed, it’s almost time to fly!   Please read the important information below on Recorder 

operation before using it in your plane. 

 

The Recorder’s LED 
 

The Recorder’s LED serves several purposes.   When the Recorder is powered on when installed in your Flight, the LED flashes a 

number of times to indicate your 4.8 or 6 volt battery’s charge state at power-up time.   Five flashes indicates a fully charged battery, 

and three or fewer flashes indicates that the battery is likely not safe to use.   Loading can affect these readings, of course. 

 

IMPORTANT:  The Recorder’s battery indicator should be used as a guide only:  you need to verify that the LED gives 

accurate results with your system, and you need to make sure that your battery’s charge state is sufficient before flying under 

the appropriate loads.    

 

WARNING:  The Recorder gives charge level indication for both 6 volt and 4.8 volt batteries, and attempts to detect which is 

installed automatically.     

Be aware that if you have installed a 6 volt battery and it goes so dead that it looks like a fully charged 4.8 volt battery, the 

Recorder will flash five times  

because it thinks the battery is fully charged, though the 6 volt battery is actually nearly dead!! 

 

Once the Recorder is powered up in your Flight, it will either flash one or two times every second or so.  This flash rate is longer or 

shorter depending on the capture rate.   This flashing indicates the following: 

 

One Flash -  The recorder is actively recording.   This is the normal power-up state. 

 

Two Flashes – The recorder is paused.   This has happened either because the Recorder’s data buffer is full and you have selected the 

“stop on full” mode described above, or you have manually paused the Recorder as described below in the Recorder Button section. 

 

Three Flashes – The Recorder is connected to your PC’s USB connector, and has been recognized by the PC.  

 

The Recorder’s Pushbutton 

 
The small red pushbutton on the Recorder serves two purposes. 

 

When depressed and released quickly, the button toggles between Pause and Record modes.   The LED will indicate the current mode 

as described above. 

 

When the button is depressed and held in for several seconds, the LED will flash rapidly, the Recorder’s Data Buffer will be cleared, 

and the Recorder will flash to indicate battery voltage as described above. 

 

NOTE:  All data within the Recorder will be lost when the Recorder is reset in this manner! 
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After You’ve Flown 
 

After flying with the Recorder, you can either remove the Recorder from your plane and take it to your PC, bring the plane with the 

Recorder still in it to your PC, or (if you’re lucky) use a Laptop and connect to the Recorder in the field. 

 

After you connect the Recorder to your PC’s USB interface, the LED should indicate USB connectivity with three repeating flashes 

as described above.     

 

Once the Recorder is connected, launch the Application and click on the Download From Recorder button.     This will load the 

Recorder’s Data Buffer into the Application for playback and saving. 

 

Use the play controls to play back the data.   Note that the Slider can be dragged with the mouse by clicking and holding it then 

moving it to the desired position. 

 

The application displays the following information: 

 

• Notifications – this window displays messages about the flight.   The three most common messages are: 

o Startup/Reset Detected – this indicates that the Recorder has been turned on at the time specified 

o Recorder low battery restart – this indicates that the Recorder has ‘rebooted’ because the power momentarily 

dropped below 4.35 volts.   See the troubleshooting section if you frequently see this message. 

o Glitch detected – these messages tell you what type of glitch was detected, and on what servo the glitch occurred.  

The most common causes of glitches are low receiver or transmitter battery, flying out of range of your transmitter, 

or defective receiver.   Note that it is normal to see a series of glitch notifications right after the recorder or the 

transmitter is powered up. 

• Length/Progress – when stopped, this readout indicates the total recording length.   When playing back, this meter indicates 

current time into the flight. 

• Battery Voltage – this instrument indicates the current battery voltage during playback. 

• Graphical and/or Numeric Temperatures – The application can display up to two Temperature readings in either instrument 

or numeric format. 

• Graphical and/or Numeric RPM – The application displays RPM readings in either instrument or numeric format. 

• Graphical Joysticks – Joystick positions are indicated via graphical joysticks. 

• Graphical and/or Numeric Speed – The plane’s speed, as computed from the air pitot tube can be displayed graphically and 

numerically. 

• Graphical and/or Numeric Altitude – The plane’s altitude is displayed when these options are selected. 

 

Other display options are available with optional equipment from Eagle Tree Systems. 

 

Multiple Session Support 
Depending on the length of your modeling sessions, it is often possible to record multiple runs into the Recorder without having to 

clear the buffer or overwrite data.    The Recorder application will split multiple sessions automatically for you.   By clicking the 

“Sessions” option in either the playback or graphing pages of the app, you can display a separate session, or all sessions 

simultaneously.   When graphing all sessions simultaneously, vertical gray bars on the graph indicate where sessions start. 

 

Note that a new session is created in the logger each time it is powered off and on. 

Saving Flight Files 
After downloading flight data, if you wish to save the data to play back later or to share with friends, save the file with the File->Save 

Recorder File menu.   Note that the file is saved with a .FDR extension by default. 

 

Graphing/Spreadsheet Compatibility 
The Recorder application has extensive graphing capability built in.   Just click on “Graph Data!” on the toolbar to graph loaded data.    

Click on the HELP button on the graphing page for more information on graphing.   

 

Also, the Recorder’s Data File is compatible with Excel ™ spreadsheet software, and perhaps other spreadsheet brands.   Using 

Excel™ is useful for graphing the data output from the recorder. 

 

To load in Excel, save the data file from File->Save Recorder File, and in Excel™ choose File->Open, and select “All Files” in the 

“Files of Type” box.   Navigate the Excel dialog box to the location you saved the .FDR data file, and click on the filename.    Excel 

should then bring up the “Text Import Wizard”.   Choose the “Delimited” option, and on the next page choose “Delimited with 

Spaces”.   The data should then load correctly in Excel.   
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The format of each line of data in the file is: 

 

First Line:  Plane Name 

Second Line: Data about your plane’s setup.   This line is needed to allow sharing of your flight files with others. 

Third line:  header indicating what each of the fields represents.  These columns are: 
Aileron Elevator Throttle Rudder Altitude RPM Speed Rec-Bat*10 Temp1*10 Temp2*10 Amps*100 

PackVolt*100 GForceX GForceY ThermoA ThermoB IsEvent EventError EventData Timestamp 

  

The first four entries indicate servo positions.    The values correspond with the length of the servo pulse for each servo.   A lower # 

means the pulse was shorter.   A value of zero corresponds to a length of about 740uSec, and a value of 254 means about 2.25mSec.    

 

 

If IsEvent is 1, the record contains event data as well as regular data.   Typical events are power-up (restart), and servo glitches. Ignore 

the non-event fields when IsEvent is set to 1. 

 

Event Codes in the “EventCode” field are as follows (the first one is 0).  Note that “internal” errors should be reported to Eagle Tree 

Systems: 

  

ERROR_BEGINPOINTER_INVALID - internal, 

 ERROR_ENDPOINTER_INVALID - internal, 

 ERROR_INIT_POINTERS_INVALID - internal, 

 ERROR_INITIALIZE_FAILED - internal, 

 ERROR_CANT_SEND_HEADER - internal, 

 ERROR_CANT_SEND_ANALOG_PACKET - internal, 

 ERROR_CANT_SEND_DATA_PACKET - internal, 

 ERROR_BATTERY_LOW – battery has fallen below a safe level for an extended period of time, 

 ERROR_BATTERY_DEAD - not used 

 ERROR_RESTART – the recorder has been restarted normally, 

 ERROR_NESTED_INT_DISABLE - internal, 

 ERROR_ILLEGAL_INT - internal, 

 ERROR_LOW_BAT_RESTART – the recorder has been restarted due to a brownout, 

 ERROR_SERVO_GLITCH_MISSED – a servo pulse was missing, 

 ERROR_SERVO_GLITCH_SHORT – a servo pulse was shorter than 740uSec, 

 ERROR_SERVO_GLITCH_LONG – a servo pulse was longer than 2.25mSec, 

  

Timestamp indicates when each record was collected.   The timestamp is in milliseconds. 

 

Email us if you need more information on the file format. 

 

Happy Flying!! 

 

Troubleshooting 
 

Below is a list of problems that may be encountered, and steps to remedy them.   If your particular issue is not addressed by the 

below, see the Flight Support page on http://www.eagletreesystems.com or email info@eagletreesystems.com.   Include a full 

description of your problem, your machine configuration, brands/models of receivers, transmitters and servos, application and 

Recorder firmware version if possible (from Help->About in the app) and any other relevant details. 

 
Issue:  My PC does not recognize the Recorder. 

Solution:  Try to eliminate the problem in the following ways: 

o Disconnect all other USB peripherals from your PC (if possible) and try the Recorder again. 

o Try the Recorder on a different PC.   If it works, there may be a misconfiguration with your PC. 

o Try the Recorder with a different USB cable, if you have one.  If this works, your cable has been damaged. 

o Try rebooting your PC – occasionally USB support gets disabled with some PCs. 

o Try the other USB connector on you PC if it has two. 

o Ensure that USB is enabled within your Operating System by checking in Device Manager.   You’ll need to see your 

Windows™ documentation to determine how to do this on your particular OS version. 

 

Issue:  I am seeing servo jitter or observing reduced range during range checking, after installing the Recorder and sensors. 

Solution:   
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Chances are that RF interference is being channeled from your engine or other noise source, through your recorder, and 

to your receiver.   Spark ignition engines have more of a problem with this than nitro or electric, due to the RFI generated by the 

ignition circuitry.  Never fly if your plane can’t pass a range check!!    There are a few possibilities to remedy this.    

• Ferrite cores can often be used to filter out the RF interference.   Snap-on RF ferrite cores are available from Eagle Tree 

Systems, Radio Shack or other sources.    Often a single ferrite snapped around all the wires leading from the engine will 

eliminate this problem. 

• If a single ferrite does not remedy the situation, an additional ferrite snapped around all the servo Y cables provides 

additional filtering.   

• If ferrites do not correct the problem, it may be necessary to disconnect the Y cables from your recorder, and not record servo 

positions.   This would be an extreme case, however.   Note that if you have to take this step, it is necessary to power the 

recorder from a separate backup battery as described below. 

 

Issue:  RPM is not working correctly 

Solutions:  

• Check to make sure your sensor to magnet gap is around 2mm or less. 

• Check the magnet polarity mounting.  The magnet should have been glued so that the red line faces down, away from the 

sensor, and the writing on the sensor faces the magnet.   If you inadvertently glued the magnet so that the red line is facing 

UP, flip the sensor over so the "non printed" side faces the magnet. 

• Make sure that under Choose What to Log in the app, you have checked RPM. 

• Make sure that the RPM sensor is plugged into the correct slot on the recorder (should be the bottom slot next to the temp 

sensors). 

• Connect the recorder to the computer and launch the app.   Then, choose Tools->Live Mode.   Make sure that the RPM gauge 

is displayed, and spin the magnets, or wave the magnets by hand in front of the sensor.  Try both sides of the magnets and 

both sides of the sensor.    See if the RPM reading jumps.   If it does not, email support@eagletreesystems.com. 

 

Issue:  My plane shows an airspeed or variation during warm-up on the ground as I rev the throttle. 

Solution:  This problem will happen when the Pitot Tube’s opening is being hit by prop-wash.   The solution is to move the tube 

farther away from prop airflow.   Note that slight variations in speed is normal. 

 

Issue:  The recorder seems to stop recording mid-flight.  

Solution:  The recorder shuts off if it detects a very low battery for an extended period of time.   Download the flight data, and if you 

see the battery voltage is below 4.5 volts constantly, the recorder likely shut off.    Charge or replace your battery, or install the 

optional battery backup harness with a small backup battery.   Also, if you have the recorder set up to pause when its buffer is full, 

and the buffer becomes full during flight, the recorder will stop recording. 

 

Issue:  I have a fully charged battery, but the recorder frequently shows “Low Battery Restart” Notifications when playing back data. 

Solution:   The recorder shuts down immediately if the power goes below 4.35 volts for more than a few milliseconds, and logs this 

occurrence when the power returns to above 4.35 volts.   If your battery’s voltage frequently drops this low, you may be 

underpowered, and may want to consider getting a bigger battery.   It is however not too unusual for this to happen with 4 cell packs 

and some servos with acrobatic flying.   If this becomes a significant problem, it can be eliminated by moving to a 5 cell pack or 

adding a secondary battery with the optional backup battery harness as described above. 

 

Issue:  My plane’s altitude reading does not appear to be correct (NOT PRO MODEL) 

Solution:   If you get lots of altitude variation, check to see if there are openings in the front of your plane that allow air to enter and 

increase pressure inside the fuselage.   If your plane is not airtight or at least sealed well up front, you may have altitude jumpiness, 

since the altimeter measures changes in air pressure.   If you have this problem and/or want very accurate altitude measurements, a 

static source can be obtained from the side of the fuselage by following these instructions: 

1. Remove the Recorder’s case top. 

2. There is a predrilled hole to accommodate an external altitude tube.   Look at the back of your recorder cover, and use an x-

acto knife to carefully cut the label around the hole.     

3. You can now install an external altimeter tube to the nipple of the altimeter sensor just like you do the pitot tube for airspeed, 

using an extra piece of rubber pitot tube, or similar.   The rubber tube (or a short piece cut from the plastic tube) should be 

mounted absolutely flush with the side of the fuselage, so that the mouth of the tube is pointing perpendicular to the direction 

of plane travel.     The location of the static tube should be chosen so that the least disturbance of air possible occurs.    

 

Flight Data Recorder Specifications 

 
Airspeed: around 9 MPH minimum (around 4 MPH for PRO), approximately 290 MPH maximum 

Altitude: 0 to approximately 32000 feet, in approximately 8 foot increments (1’ increments for PRO) 

Operational Voltage: 4.35V to 7.0V 
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Current Draw:  < 35 mA @ 4.8 V 

Weight:  Recorder, 4 Y cables, RPM and temp sensors, and Pitot tube, approximately 1.5 oz. 

Temperature:  Dual inputs, 0 degrees F to 424 degrees F 

RPM range: approx 100 RPM to 50000+ RPM 

Units supported:  English and Metric 

Measurements:  1.97” x 1.38” x 0.67” 

Record Time:  Varies with sample rate, parameters being recorded, and “activeness” of flight.  Anywhere from around 30 minutes to 

hours is attainable depending on these settings.    (PRO recorder will record 4X longer) 

 

Limited Warranty 

Eagle Tree Systems, LLC, warrants the Flight Data Recorder to be free from defects in materials and workmanship for a period of one 

(1) year from the date of original purchase.    This warranty is nontransferable.   If your unit requires warranty service during this 

period, we will replace or repair it at our option.   Shipping cost to us is your responsibility. 

To obtain warranty service, contact us by phone, fax or email to request an RMA number.   No returns will be accepted without this 

number.      

This limited warranty does not cover:  

• The Software included with the Flight Data Recorder.   See the Software license agreement for more information on Software 

restrictions. 

• Problems that result from:  

o External causes such as accident, abuse, misuse, or problems with electrical power  

o Servicing not authorized by us  

o Usage that is not in accordance with product instructions  

o Failure to follow the product instructions  

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY 

FROM STATE TO STATE (OR JURISDICTION TO JURISDICTION). OUR RESPONSIBILITY FOR MALFUNCITONS AND 

DEFECTS IN HARDWARE IS LIMITED TO REPAIR AND REPLACEMENT AS SET FORTH IN THIS WARRANTY 

STATEMENT. ALL EXPRESS AND IMPLIED WARRANTIES FOR THE PRODUCT, INCLUDING, BUT NOT LIMITED TO, 

ANY IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 

PURPOSE, ARE LIMITED IN TIME TO THE TERM OF THE LIMITED WARRANTY PERIOD AS DESCRIBED ABOVE. NO 

WARRANTIES, WHETHER EXPRESS OR IMPLIED, WILL APPLY AFTER THE LIMITED WARRANTY PERIOD HAS 

EXPIRED. SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS 

LIMITATION MAY NOT APPLY TO YOU.  

WE DO NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN THIS LIMITED WARRANTY OR FOR 

CONSEQUENTIAL OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, ANY LIABILTY FOR THIRD-

PARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST 

DATA OR LOST SOFTWARE. OUR LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE PRODUCT 

THAT IS THE SUBJECT OF A CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH WE ARE RESPONSIBLE.  

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 

SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.  

 

Product Warranty Registration 

 
Registering your product means that we can send you important updates and other notifications.  Please fill out this form (or a copy) 

and mail or fax it to Eagle Tree Systems.   Or, email the info to sales@eagletreesystems.com.   Note that if you purchased your item 

directly from Eagle Tree Systems, this is not necessary. 
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Eagle Tree Systems Warranty Product Registration: 

 

Name:__________________________________________________________________________ 

 

Address: ________________________________________________________________________ 

 

Phone: ________________________________  Email: ___________________________________  

 

Product(s) Purchased: ________________________     Date Purchased:______________________ 

 

Where did you purchase your product?_________________________________________________ 

 

Where did you hear about our product? _______________________________________________ 

 

Any features or additions you would like to see? _________________________________________ 

 


